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Introduction

This document 1s designed to help you use Rivio Payroll Manager Online, Rivio
Office Manager, and Rivio Payroll Manager Office Edition for your small
businesses. Included in this document are:

®  Specific setup and configuration procedures, including initial step-by-
step setup and ongoing setup and maintenance specific to each
product.

* Information about how the different parts of each application integrate
with each other and with outside applications

® Best practices information that offers helpful suggestions on how to
best use Rivio products

While your employees can easily use the different modules of Rivio Office
Manager and Rivio Payroll Manager Office Edition, many of the individual parts
are designed to integrate with other parts. Information can easily move from one
area of the system to another, making your work flow more efficiently.

To begin that process, you'll need to perform or arrange for some initial setup and
configuration. This guide will help you determine the best way to do this for your
business.

Using This Guide

This guide contains instructions for different products. Not all procedures apply
to all products. The products that each procedure applies to are listed immediately
before each procedure.

For example, a procedure that applies to Rivio Office Manager and Rivio Payroll
Manager Office Edition, but not Rivio Payroll Manager Online, will look like this:
O RIvio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIvio OFFICE MANAGER
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You can get additional online Help (in addition to this manual) anytime you need
more mnformation.

Setup Methods

O Rivio PAYROLL MANAGER ONLINE
O R1vio PAYROLL MANAGER OFFICE EDITION
M RIviO OFFICE MANAGER

You can get Rivio Office Manager set up in three different ways. The following
table will help you decide which way 1s best for you:

Setup ethoa | Descrpuon

Outsource You can arrange for someone outside your company to set up
and configure your company's information. You need only to
provide the information about your company and your
employees.

Note: Not all companies that offer this product also offer the
outsourcing service.

Delegate You can assign specific administrator roles to different
employees in your company and delegate the setup of the parts
of the system to those people. For example, you can assign HR
Administrator access rights to someone in your HR
department. That employee will have access to enter employee
information and will be presented with a step-by-step setup
page that will show their areas of responsibility and guide them
through the setup process.

Self Setup You can perform the setup yourself. When you sign in, a step-
by-step page will guide you through a sequence of setup
wizards, allowing you to enter all the mnformation to get your
system running quickly.

Information Needed for Setup

Whether you outsource your setup, delegate it, or do it yourself, you'll need to
have (or provide) information about your company and its employees. The type of
information you'll need will depend on what parts of the system you plan to use.

For example, to set up your company profile, you'll need address(es), phone
number(s), e-mail address(es), and so on. To set up areas that use employee
information, you’ll need names, e-mail addresses, social security numbers, and so
on.

Click the What documents do I need? link on the Step-By-Step Setup page for

more information.




To use the Setup
Assistant while
setup is still
incomplete

To use the Setup
Assistant anytime

SETUP & CONFIGURATION GUIDE

Outsourcing: The Setup Assistant

The Setup Assistant allows you to outsource your company setup. You indicate
the areas of the system that you would like help setting up. The system then
forwards that information securely to the outsourcing company that will set up
your system.

The Setup Assistant, when available, can be used from the System Setup Options
page (until the first employee record has been entered into your system, after
which the Setup Options page will disappear), the Step-By-Step Setup page, or the
System Setup page. The availability of the Setup Assistant depends on the
company that provides your product version (not all companies offer the option
to outsource your company setup).

1. Sign in to the site. A message box appears asking if you want to complete
setup.

2. Click Yes.
3. Ifyou see the Setup Options page, click Outsource Setup.

If you see the Step-By-Step Setup page, click Setup Assistant.
4. Enter your information mn the contact fields.

5. Click Finish.

Click My Company, then under System Admin, click System Setup.
Click Setup Assistant.
Enter your information in the contact fields.

Click Finish.

> w N

System Setup: Delegation and Self Setup
The parts of the system that you have responsibility for on the Step-By-Step Setup

page depend on your access rights. For example, if you are a System
Administrator, you can view and make changes in any setup section. If the System
Administrator has delegated setup to you, you’ll be able to click on and set up only
the areas that you have been given responsibility for. For example, if you are an
HR Administrator, you won’t be able to view or make changes in the Employee
Access Rights section. In fact, any sections that you don’t have access rights to will
be grayed out.
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Until you complete imnitial system setup, the Step-By-Step Setup page will remain
accessible, providing links to wizards that will guide you through each section’s
setup process.

The Step-By-Step Setup page will remain until all steps are marked either No#
appropriate or Complete. Once all steps have either of these statuses, the System
Administrator (only) will see a Setup Complete button at the bottom of the page.
Clicking the Setup Complete button will replace the Step-By-Step Setup page
with the System Setup page (My Company > System Admin > System Setup),
which provides links directly to the setup pages for each type of information.
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Part 1

INITIAL SETUP
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wizard
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Setup Wizards

O Rivio PAYROLL MANAGER ONLINE
M RIVIO PAYROLL MANAGER OFFICE EDITION (FOR NON-PAYROLL ITEMS)
M RIviO OFFICE MANAGER

The Step-By-Step Setup for your system provides several wizards to help make
entering information about your company and your employees easy. The wizards
step you through the data-entry process.

The setup wizards must be completed in order, as nformation entered in one
wizard is used in subsequent wizards.

The System Administrator can complete all of the setup wizards. If you’ve been
delegated administrator access rights during initial company registration, such as
HR Administrator or Payroll Administrator, you can complete only the wizards
for your area(s) of responsibility.

Each of the setup wizards guides you through a step-by-step process for entering
specific information about your company or its employees. The setup wizards are
available for you to use until all the areas for your company are set up.

Once your company’s setup is complete, you’ll be able to set up and maintain
different areas directly. You will no longer be able to access the setup wizards.

1. Sign in to the site.

You’'ll see a message asking 1f you want to go to the system setup page (unless
it is your first time in the site, in which case you’ll first see the Terms of
Service page and Change Your Password page before you continue).

2. Click Yes.
3. Click the title of the setup wizard you want to run.

The wizards must be completed (or marked Not Applicable) in order, from
top to bottom.

4. On the opening wizard page, click Continue.
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6
7
8.
9

In each wizard page, enter the information about your company or its
employees.

Click Next on each wizard page up to the last page.
On the last wizard page, click Finish.

Select Complete.

Click OK.

Note: If you clicked No in step 2 and entered the site, you can still get to the
Step-By-Step Setup page by clicking My Company > System Admin > System
Setup (if you’re a System Administrator) or My Work > Quick View >
Complete System Setup (if you’re not a System Administrator), and then
continuing with step 3.
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Part 2

ONGOING MAINTENANCE
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Company Profile

The company profile is the general information about your company, the main
company (corporate) address, plus addresses of any branch locations.

When you (or someone in your company) originally registered, some of the basic
information about your company was entered as part of the registration process. If
you’re using Rivio Office Manager or Rivio Payroll Manager Office Edition, you
should complete all the information about your company so that it is available to
all employees. That information includes the company profile and company
addresses.

Maintaining Company Profile Information

The Company Profile area contains all the descriptive mnformation about your
company. Your employees can use this page to check your company’s fax
numbers, ZIP codes, and other contact information from time to time.

To enter or modify RIVIO PAYROLL MANAGER ONLINE
company RIVIO PAYROLL MANAGER OFFICE EDITION
information

R1ViO OFFICE MANAGER
Click My Company, then in Company Info, click Profile.

Click Edit Profile to enter or modify basic company information.

Rt C I CA I Y |

Click Add Address to enter information about a new company location.

Company Addresses

One address for your company is already entered by default: the address you
entered when you registered. If your company has more than one location, you
can enter the address information about your other locations.

11
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T REA

SREN

RIVIO PAYROLL MANAGER ONLINE

RI1VIO PAYROLL MANAGER OFFICE EDITION

R1viO OFFICE MANAGER

Click My Company, then in Company Info, click Profile.

Click Add Address.

Enter the information about the location, then click Save.

12
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Departments

Many companies use departments to classify their employees by functional area or
by other dividing factor. Department information is also often used for payroll
processing. Once you set up your company’s departments, you can then assign
each employee to a department.

Maintaining Department Information

RIVIO PAYROLL MANAGER ONLINE

RI1VIO PAYROLL MANAGER OFFICE EDITION

R1viO OFFICE MANAGER

Click My Company, then in Company Info, click Departments.

Click Add Department.

“w v P REAF

Enter the department name and (optional) department ID.

When used, the department ID 1s your own combination of letters and
numbers for tracking and identifying department information.

Click Save.

B

RIVIO PAYROLL MANAGER ONLINE

RIVIO PAYROLL MANAGER OFFICE EDITION

RIVIO OFFICE MANAGER

Click My Company, then in Employee Records, click Employee Info.
Click the name of an employee.

Click Work.

In the Department Name drop-down list box, select a department name.

Click Save.

ooa 0N mRER

Note: Employees can be assigned to only one department.

13






To set up pay
frequencies

SETUP & CONFIGURATION GUIDE

Payroll

The information you enter during payroll setup is used in many other areas of the
system. That information mcludes:

= Pay frequency
= FEarnings types
* Deduction types
For Rivio Office Manager users, you can also prepare your payroll for submission

to an external payroll processor. When you work with an external payroll
processor, use the data and reports within the system to help this process.

The payroll feature tracks and highlight changes to employee data, providing you a
detailed list of changes to consider for approval prior to payroll processing. This
approval step ensures accuracy and lets you stay in control of the data submitted
to your payroll provider.

Maintaining Payroll Information

Pay Frequencies

You can have up to four different pay frequencies: weekly, every two weeks, twice
a month, and monthly. You can make more than one pay frequency active if you
have employees receiving pay on different schedules. The pay schedules you set up
here will be available for you to select when you create a payroll. They will also
appear in employees’ records.

RIVIO PAYROLL MANAGER ONLINE

RI1VIO PAYROLL MANAGER OFFICE EDITION

R1vIO OFFICE MANAGER

Click My Company, then in Payroll, click Setup.

MEROO

Click Pay Frequency.

15
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3. In the Pay Frequency and Schedule section, select the check boxes for any pay
periods you want available.

4. For each pay frequency you select, enter the date details, which are used to
pre-populate the actual pay periods.

Pay Frequency Options

Weekly Enter the date that will be the last day of your first pay
week. Pay 1s 52 times per year.

Every Two Weeks Enter the date that will be the last day of the first two-
week pay period. Pay is 26 times per year (every two
weeks).

Twice a Month  Select the two dates each month that will be the last days
of each pay period in the month. Pay is 24 times per year
(twice per month).

Monthly Enter a day of the month that will be the last day of the
pay pertod. Pay 1s 12 times per year.

5. If you are using more than one pay frequency, select which one will be the
default for new employee records in the Pay Frequency Default Setting
drop-down list box.

6. Click Save.

Earning Types

Earning types are the types of hours worked, such as regular time, overtime,
double time, sick time, paid time off, and so on.

O RIvio PAYROLL MANAGER ONLINE

O Rivio PAYROLL MANAGER OFFICE EDITION

M Ri1vio OFFICE MANAGER

a c D=

Click My Company, then in Payroll, click Setup.

Click Payroll Information.

Click Earnings.

Enter a name and description for each different earning rate.

For each earning type entered, select if based upon hours worked.

Select Yes if based on houtly amounts worked, such as regular earnings,
overtime, paid time off, and so on.

Select No if not based on hourly amounts worked, such as for a bonus.

Select the Exempt or Non-Exempt check boxes if the rate applies to those
classes of employees.

16
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7. Click Add if you need to add more codes.
8. Click Save.

Deduction Types

This tab lists the descriptions of all the deductions your company uses for its
payroll. If you're submitting to an external payroll processing vendot, (not
integrated with Rivio Office Manager), be sure to use the same deduction
descriptions and reference numbers as established with your current provider.
This will allow you to generate employee detail in a format that your current
payroll provider uses.

O R1vio PAYROLL MANAGER ONLINE

O RIviOo PAYROLL MANAGER OFFICE EDITION

M RIviO OFFICE MANAGER

1. Click My Company, then in Payroll, click Setup.

2. Click Deductions.

3. For each deduction type, enter a name, a description, and a unique reference
number.

4. Click Add if you need to add more deduction types.

5. Click Save.

17
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Employee Records

Many parts of this site are designed to work together, which requires proper
configuration. For example, you will need to set up the Time Sheets propetly to
integrate with payroll, or set up your chart of accounts in the Accounting area to
use for invoices and expense reports.

Before you begin configuring these other areas, however, you should enter all the
mformation about your employees.

Maintaining Employee Information

Employee records, which include basic information about your employees, are
generally imported or input by your Human Resources Administrator. Some of the
mformation about employees automatically generates the Employee List, Job
Roles, and the Organization Chart. This nformation 1s viewable by all users.

You can import employee information into the system directly from a
QuickBooks® file or from a correctly structured spreadsheet file. You can also
enter information about your employees manually.

You can also set up departments in your company, then assign employees to those
departments after their information has been entered. You should set up
departments before you import or enter your employee information. See
“Maintaining Department Information” on page 13.

Dependencies

Some of the information about employees 1s used by other areas of the system.
For example, on the Wotk tab of an employee's recotd, you can select the
employee’s supervisor. That selection 1s used to build the Ozganization Chart.
Other employee information appears automatically in the Job Roles area.

Employee Data Setup

After your system setup is complete, you perform regular setup tasks in the
Employee Records Setup area.

19
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Importing from QuickBooks
O Rivio PAYROLL MANAGER ONLINE

M RIvVIO PAYROLL MANAGER OFFICE EDITION
M RIvIO OFFICE MANAGER
1. From within QuickBooks, export an .IIF file.

In QuickBooks 2000: File > Utilities > Export.

In QuickBooks Pro 99: File > Export.

Click My Company, then in Employee Records, click Setup.
Click Import Employees from QuickBooks.

Clear all check boxes except Employee List, then click Browse.

Find the .IIF file you just exported from QuickBooks and click Open.

AL

Click Import.

Importing from a Spreadsheet File

When importing employee information from a spreadsheet file, that file must have
only specific information arranged in a specific way. The information includes:
first name, middle name, last name, salutation, two address lines, city, state, ZIP,
social security number, home phone, work phone, and work e-mail address.

On the Import Data from a Spreadsheet File page, there is a link to a sample file
with instructions. You can download and use this file to import your data.

O Rivio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M R1ViO OFFICE MANAGER

1. Click My Company, then in Employee Records, click Setup.

2. Click Import Employees from a Spreadsheet.

3. Follow the steps of the Import Wizard. Click Next as you complete each step.
4. Click Finish when you complete the wizard.

Entering Manually

You enter employee information manually using one of two wizards. The Quick
Version wizard allows you to enter the essential employee information: name,
status, and used for payroll. The Payroll Version wizard allows you to enter
complete employee information.

20
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O RIvio PAYROLL MANAGER ONLINE
M RIVIO PAYROLL MANAGER OFFICE EDITION
M RIvio OFFICE MANAGER
Click My Company, then in Employee Records, click Setup.

1
2. Click Employee Records.

3. Click either of the Add Employee(s) Wizard links.

4. Follow the steps of the Import Wizard. Click Next as you complete each step.
5. Click Finish when you complete the wizard.

Note: Because one of the pieces of information you can select for an employee is

the individual that employee repozts to, you may want to enter employees “top
down,” with higher-ranking employees first.

Reminders

Rivio Office Manager offers the option of receiving e-mail reminders of
employee-related events. You can receive reminders for the following employee
events:

= Performance Evaluation
* Visa Expiration

*  Completion of I-9

* Birthday

" (Work) Anniversary

Reminders are not defined site-wide. Rather, anyone who has System
Administrator or HR Administrator access rights can set up their own individual
reminders.

O Rivio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIVIO OFFICE MANAGER

1. Click My Company, then in Employee Records, click Setup.

Click Remindetrs.

2
3. Select the reminder you want to use, then select a reminder time.
4

Click Save.

21
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Accounting

Note: The information in this chapter applies only to Rivio Office Manager and
Rivio Payroll Manager Office Edition:

O RIvio PAYROLL MANAGER ONLINE
M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIvio OFFICE MANAGER

You’'ll set up two types of information in the Accounting Preferences setup:
®  QuickBooks integration

* Expense Report and Invoice numbering

QuickBooks Integration

The Accounting area provides two different ways of supporting your accounting
procedures on Rivio Office Manager. The two modes of operation are:

= QuickBooks Intetface Off
" QuickBooks Interface On

Differences Between Modes

QuickBooks Interface Off: In this mode, you can manually enter and manage
the online Chart of Accounts to match the chart of accounts in your company’s
accounting system. Accounts entered here are used in Expense Reports. In this
mode, you also access the Accounts List, Customer List, and Setup page, but you
cannot directly import or export data.

QuickBooks Interface On: In this mode, you can use the QuickBooks
synchronization feature in the Accounting area to capture transactions and
synchronize data between your system and QuickBooks. Automatically, the
Invoices, Time Sheets, Expense Reports and HR applications will have access to
the same customer accounts you use in QuickBooks! This convenient feature
makes getting started faster and immediately compatible with your existing records
and processes. In this mode you no longer have direct access to the Accounts List.

23
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Instead, you now have access to the Import, Export, and Re-Export functions.
The Import function allows you to import your chart of accounts, customer list,
employee list, and credit terms. For Export, your customer list, employee list, and
the Accounts Payable generated by Expense Reports can be exported to
QuickBooks.

In both modes you can import Employee Records using a spreadsheet (.CSV
format) file through My Company > Employee Records > Setup.

The Accounting area interacts with the Time Sheets, Expense Reports, Invoices,
and Human Resource features. When the QuickBooks interface is on, the
imported chart of accounts and customer records shows up in Expense Reports
for easy inclusion in the expense repozts you create. For Time Sheets and
Invoices, the imported customer records show up for inclusion. Similarly, in the
HR feature, the imported employee records appear, which allows the HR
administrator to expedite employee record management.

When the QuickBooks interface is off, the chart of accounts and customer records
you create in the Accounting area will flow into Expense Repotts, so those key
records can be accurately referenced in new expense reports. While the chart of
accounts does not show up in Time Sheets and Invoices, the customer records
you create will be available in those applications.

With document serial number sequencing, the numbers set on the Setup page in
the Accounting area automatically provide the correct sequence number every
time a new expense report or invoice is created.

O R1vio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIvIO OFFICE MANAGER

1. Click My Company, then in Accounting, click Setup.

2. Click Set QuickBooks® Integration Preferences.
3. Select On.
4

Select the types of information you want to import and export from your
QuickBooks account files and integrate with the system.

Click Save & Return.
6. Click Finish.

o

QuickBooks Information

If you’re a QuickBooks user, the best way to use the Accounting area is to start by
importing your chart of accounts, customer list, employee list and the credit terms
into Rivio Office Manager. This ensures that all record types that you use in your
accounting software are duplicated in Rivio Office Manager for accurate
accounting reference. Importing is a fast, easy and efficient way to populate these

24
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key record types. Additionally, once the imported record types are used within an
expense report, you can export the finalized expense report into QuickBooks
without having to re-type anything. You can also export your customer list and
employee list to ensure that records are synchronized between QuickBooks and
Rivio Oftfice Manager.

Best Practices If you do not use QuickBooks, use the QuickBooks Interface Off mode and do
the following:

1. Review the pre-populated Chart of Accounts (Account List) and tailor it
to your preferences.

2. Create customer and project records (Customer List) so that they can be
accurately referenced in Expense Reports, Time Sheets and Invoices.

3. Set your expense report and invoice serial number sequencing to control
document numbers.

Expense Report and Invoice Numbering

You can define how you want your expense reports and invoices numbered. For
each, you can add an alphanumeric prefix and suffix, and you can also set a
starting number.

If you do not specify a prefix, suffix, or starting number, both expense reports and
mnvoices will use neither a prefix nor a suffix, and will start numbering with 1
(actually, 000001).

To set up expense O RIvio PAYROLL MANAGER ONLINE

report and invoice M RIVIO PAYROLL MANAGER OFFICE EDITION

numbering M R1viIO OFFICE MANAGER

1. Click My Company, then in Accounting, click Setup.

2. Click Set Expense Report and Invoice Sequencing.

3. Enter any prefix or suffix for either expense reports or mvoices, then
optionally enter a starting number other than 0.

4. Click Save & Return.

5. Click Finish.

25
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Policies & Procedures

You can use the Policies area to post all your company’s policies and procedures
so employees can view them in a single place. Additionally, you can alert
employees by e-mail of changes to a particular policy. The Policies area saves you
the trouble of copying and manually distributing updated pages each time a
change has been made to a policy in the company. These policies will appear as
mndividual policies by name, allowing your employees to access them individually,
rather than as part of a bigger handbook.

See the online Help system (click Help) for more information on how to add,
modify, and delete policies and procedures.

27
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Access Rights

This chapter contains information about granting employees access, managing
password security, and providing the various types of access rights.

Granting employees access

To use the system, employees must have access tights. When an employee's
information 1s first entered into the system, an employee record is created, but no
access rights are given. The employee cannot yet use the system and has a status
of “No Access.” (See “Maintaining Employee Information” on page 19 for
information on how to enter employee information.) You must separately grant
access rights for that employee.

For security purposes, only users with System Administrator access rights can
grant any level of Rivio Office Manager access to other employees.

Granting an employee access involves creating a User ID and defining access
rights. The default access right is Employee. Access rights define what a user can
do, and what areas of Rivio Office Manager the user can view and enter. For
example, if an employee does not have Human Resources Administrator access
rights, that employee can neither see nor enter the Human Resources area. You
must have System Administrator access rights to grant access to new employees.
D RIVIO PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIVIO OFFICE MANAGER

1. Click My Company, then in System Admin, click Access Rights.
2. Click Assign Access. The new employee should be in this list.

3. Click the employee's name.

4. Select the access rights you want to provide.

Anyone who is granted access receives Employee-level access rights.
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Employees who are granted Manager access rights are those to whom other
employees submit invoices, time sheets, purchase requests, and so on. Users
can submit these forms to a select list of users who have Manager status.

5. If there 1s no e-mail address, enter the employee’s e-mail address.

6. Click Create Account.

Note: Employees are not automatically notified when their accounts are created.
Notification is a separate step.

You must have System Administrator access rights to notify employees of their
new or modified access rights.

O Rivio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIVIO OFFICE MANAGER

1. Click My Company, then in System Admin, click Access Rights.

Click Notify Employee/Change Access Rights.
Select the check box next to the employee's name.

Click Notify Selected Employee(s).

> W N

The employees will receive two e-mails. Each e-mail has the URL for the site. One
e-mail has the Company ID and User ID, the second e-mail has a randomly
generated password. The employee will be asked to change their password when
signing in the first time.

Passwords

A password 1s the third piece of nformation (along with company name and user
name) that uniquely 1dentifies an employee as having the right to access the site.
Employees should be encouraged to keep passwords private, and to use
passwords that are difficult to guess.

You must have System Administrator access rights to reset an employee's
password.

O Rivio PAYROLL MANAGER ONLINE

M RIVIO PAYROLL MANAGER OFFICE EDITION

M RIVIO OFFICE MANAGER

1. Click My Company, then in System Admin, click Access Rights.
Click Notify Employee/Change Access Rights.

Click the name of the employee.

Click Reset Password.

> W N
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The employees will receive two e-mails. Each e-mail has the URL for the site. One
e-mail has the Company ID and User ID, the second e-mail has a new, randomly
generated password. The employee will be asked to change their password when
signing in the first time.

You can change your own password at any time.

RIVIO PAYROLL MANAGER ONLINE

RIVIO PAYROLL MANAGER OFFICE EDITION

RIVIO OFFICE MANAGER

Click My Work, then under My Profile, click Password.

Enter your current password.

© v =R E O

Enter your new password twice.
Passwords must be 8-16 characters with no spaces.

Click Save.

B

RIVIO PAYROLL MANAGER ONLINE
RIVIO PAYROLL MANAGER OFFICE EDITION
RI1ViO OFFICE MANAGER

—O00™

Click My Company, then under System Admin, click Password.

Enter your current password.

w N

Enter your new password twice.
Passwords must be 8-16 characters with no spaces.

4. Click Save.
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Company Communication

The company communication area allows you to communicate all your company’s
announcements, events, and schedules to your employees. To optimize these
features for your company, you should first customize your employee
communication page: the Quick View page in the My Company tab. This
customization allows you to choose whether you would like certain features to
appear on your company page for all employees to see. For instance, the Job Roles
feature allows you to define responsibilities at your company. If you decide this is
not applicable or useful to your company, you may elect to eliminate it from the
menu. You can customize the following features:

* Company Announcements
= Company Events
* Message of the Day
Much of the setup is performed in the My Company tab.

Company Announcements

Company Announcements relate to any type of information you want to
communicate with your employees, from daily messages to notifications of
important events. The benefit of this feature 1s that it provides a single place for
you to share information with your employees. Additionally, you can send
important announcements to employees by e-mail.

RIVIO PAYROLL MANAGER ONLINE

RIVIO PAYROLL MANAGER OFFICE EDITION

R1VIO OFFICE MANAGER

Click My Company, then in Desktop View, click Quick View.

In the Announcements area, click Add Announcement.

© N rRREDO

Enter the announcement information.
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The expiration date is the last date the announcement will appear on the
Quick View page (when you have selected to display it there). The default 1s

one month from now.

If you want e-mail sent to all employees to inform them that a new
announcement is posted, select Notify all employees via e-mail.

Only employees who have been granted access will receive these e-mail
messages.

Click Save.

If you want the announcement to appear on all users' Quick View pages, then,
in the list on the Setup Announcements tab, select the Display on Quick
View check box. If you want the displayed announcement to be marked as
new, select the Display as New check box.

The list on the Setup Announcements tab shows five items by default. You
may need to click Last (at the bottom of the list) to see the announcement you
just entered if there are more than five announcements in the list.

Click Save & Return.

Message of the Day

The Message of the Day i1s typically a daily message that can be humorous, a
quote, or any other message you would like to share with your employees.

© v =g E O

RI1VIO PAYROLL MANAGER ONLINE
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Click My Company, then in Desktop View, click Quick View.

In the Message of the Day section, click Edit.
Make any desired additions or changes.

You can use any valid HTML tagging in addition to plain text. For example, to
make some text bold, sutround it with the <b> and </b> tags.

Click Save & Return.

Company Events

The Company Events work like a company calendar. All employees can view
upcoming company events. You can present all the information about your
company-wide events to your employees in a single place.
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Toadd acompany [ RIVIO PAYROLL MANAGER ONLINE
event M RIVIO PAYROLL MANAGER OFFICE EDITION
M RIVIO OFFICE MANAGER
1. Click My Company, then in Desktop View, click Quick View.

Click Add Event.

2
3. Enter the event information.
4

Click Save & Return.
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Strategies

This chapter provides useful setup and configuration strategies for various areas of
the site. Also included is dependency information, explaining when the
information in one area is dependent on information in another area.

Time Sheets

The Time Sheets area allows houtly employees to track and submit their time
worked. Features of the Time Sheet functionality include:

® Online preparation and routing of time sheet reports.
*  Ability to enter time by project or client.

® Flexible routing capabilities allow you to easily follow company-
specific procedures for time sheets.

® E-mail notification of time sheet submission and status changes.

* Convenient time sheet display allows for easy management and status
tracking of outstanding time sheet reports as well as access to
completed time sheets.

* FElectronic notification when pre-set due dates are missed.

* History logs help ensure that proper company time sheet approval
process has been followed.

* Automated mtegration with Payroll functionality allows for
incorporation of approved time sheet data into pay period specific
payroll reports.

Roles & Privileges
There are four different roles that are in effect for Time Sheets.

System Administrator: The System Administrator 1s responsible for setting up
the company and its users (for Rivio Office Manager), including assigning access
rights to the Accounting area and user roles (Manager and Employee). The System
Administrator has access to all areas of the Rivio product. The System
Administrator will typically be the owner of the company.
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Accounting Administrator: Users with access to the Accounting area can import
data from QuickBooks and export data from the system. Accounting
Administrators also have access to set up functionality for the accounting
applications, including managing the company and customer lists. Accounting
Administrators will typically be the controller or bookkeeper. The Accounting
Administrator 1s the individual who is responsible for setting up the
Clients/Projects to which time can be chatrged.

Manager: Managers will create time sheets and time-off requests. Managers will
also have approval authority for items other than their own. Managers will
typically be owners or supervisors.

Employee: Employees are general users who will create time sheets and time-off
requests (either for themselves or on behalf of another employee). Employees will
not have access to the Accounting area or approval authority.

Configuration

If the user wants to use Time Sheets to track time by client or projects, they must
first set up those client/project records in the Accounting area. Once set up in the
Accounting area, those items will automatically show up in the select boxes
located 1n the time sheet.

No other setup 1s necessary for Time Sheets.

Approved time sheet data flows automatically into the Payroll module to help
streamline the inclusion of employee time worked (or not worked) into payroll
reports and processing. No action is required on the uset’s part to “push” the data
to the Payroll module.

Best Practices Companies should set policies for the approval and tracking method of Time
Sheet data. Specifically, employees should know to whom they need to submit
their time sheets for approval, and the frequency with which this data must be
submitted.

Expense Reports

The Expense Reports application allows you to create and route expense reports
for approval and payment. Expenses can also be tracked by project for easy,
accurate billing to your customers. Expense types are matched to your Chart of
Accounts, and expense reports can be exported to QuickBooks, elimimating the
need for re-entry into your accounting system.

Approval and Payment Process
As an expense report moves from creation to payment, it follows a series of steps
that involve approval and acceptance by the Manager.

Activity Expense Report Status I

Create new expense repott New

Submit for approval Approve and Submit for Payment?
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Activity Expense Report Status I

Approve and submit for payment Approved for Payment, or Declined
Approve for payment Accept for Payment?, or Declined
Accept for payment Accepted for Payment

Originator receives payment Completed

Roles/Privileges

Any employee with an account (User ID and Password) can create an expense
report and submit it for approval. To maintain and enforce your company’s
reimbursement policies, only managers’ names appear in the routing slip for
approval and payment of expense reports.

Note: Users can forward an expense teport for review to anyone in the company
with a login account.

Dependencies

The Expense Reports application can be used without any mitial setup. However,
there are a few features you may wish to set up to enhance the functionality of the
feature:

Customers/Projects: The Expense Repotts feature allows users to assign
expense items to customers / projects. If you want to assign expenses to
customers/projects, you must first set up your customers and projects in the
Accounting area. However, the application can be used without this feature.

To set up 1. Click My Company, then in Accounting, click Customer List.
customers and

) 2. See the online Help for details on how to add both customers and projects.
projects

Approval and Payment Routing: The System Administrator who sets up the
company’s account is assigned the Manager role, and will appear in the routing slip
drop-down box for approval and payment of expense reports. If you want to give
other users the ability to approve and/or pay expense reports, you must give them
Manager access rights. To do so, click My Company, then in System Admin,
click Access Rights. Users given Manager rights can also approve time sheets,
purchase requests, and invoices.

Setup Expense Report Numbers: Expense reports are assigned a reference
number, starting with 000001. You can customize the reference numbers by
assigning a prefix, suffix, and starting number. To customize the reference
numbers, click My Company, then in Accounting, click Setup.

Export to QuickBooks: If you are a QuickBooks user, you can easily export
expense reports data to your QuickBooks account. Expense reports that have
reached the “Accepted for Payment” status are ready for export.

To export expense report data, you must first turn on the QuickBooks interface.
Click My Company, then in Accounting, click Setup, then Set QuickBooks
Integration Preferences. Choose QuickBooks Interface On and select the
QuickBooks records that you want to import and export. Once these are selected,
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you can export expense reports by clicking My Company, then in Accounting,
click Export from Site.

Best Practices To inform your employees of your company’s expense report approval and
payment policies, you can easily create a procedure in Policies and Procedures.

Hints and Guidelines

Retract: Users can retract or “call back™ their action, such as Approve and Submit
for Payment, Decline, Accept for Payment, or Forward. A retracted expense
report returns to its previous status.

Reopen: The expense report creator (originator) can reopen his own expense
report at any status point, except when it reaches Completed. Reopening an
expense report voids all previous approvals.

Note: If, after an expense repott is exported to QuickBooks, it is retracted or
reopened, and the revised expense report is exported to QuickBooks again, you
must go into QuickBooks and manually correct the first entry.

Previewing and Printing: You can easily preview and print out expense repoxts
by opening an expense report and clicking the Print/Preview button. Another
browser will open to display the selected expense report. To preview and print,
click the View as Acrobat icon in the upper left of the screen. The expense report
will open in Adobe Acrobat. To print, click the printer icon.

Invoices

The Invoices area allows you to create and route invoices for internal approval and
then submit them to your customers. Built-in security features ensure read-only
access for customers recetving invoices. The Invoice area is linked to the customer
list, making invoice creation faster, easier and more accurate.

Approval and Receipt Process
As an invoice moves from creation to receipt of payment, it follows a series of
steps that mvolve approval and acceptance by the Manager.

Activity Invoice Status I

Create new invoice New

Submit for approval Approve and Submit to Customer?

Approve and submit to customer Approved for Payment, or Declined

Customer accepts invoice Customer Accepts Invoice?, or
Declined

Accept for payment Accepted for Payment

Receive payment Completed
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Roles/Privileges

Any employee with an account (User ID and Password) can create an invoice and
submit it for approval. To maintain and enforce your company’s invoicing
policies, only managers’ names appear in the routing slip for approval of mnvoices.

Note: Usets can forward an invoice for review to anyone in the company with a
login account.

Dependencies

The Invoices application requires minimal setup. To use Invoices, you must first
set up your customers/project records in the Accounting area. Once

customer/ project records are set up, you can select the customers / project to
invoice, and the customer’s mformation automatically appears on the invoice.

1. Click My Company, then in Accounting, click Customer List.

2. See the online Help for details on how to add both customers and projects.

The Invoices feature offers additional functionality that requires setup, as
described below:

Approval Routing: The System Administrator who sets up the company’s
account 1s assigned the Manager role, and will appear in the routing slip drop-
down box for approval of invoices. If you want to give other users the ability to
approve invoices, you must give them Manager access rights. To do so, click My
Company, then in System Admin, click Access Rights. Users given Manager
rights can also approve time sheets, purchase requests, and expense repotts.

Setup Invoice Numbers: Once an invoice is approved, it is assigned a final
invoice number, starting with 000001. You can customize the invoice numbers by
assigning a prefix, suffix, and starting number. To customize the invoice numbers,
click My Company, then in Accounting, click Setup.

To inform your employees of your company’s invoice approval policies, you can
easily create a procedure i Policies and Procedures.

Hints and Guidelines

Invoice numbers: When an invoice is created, it is assigned a system-generated
number in the format DRAFTXXXXXX. The final invoice number is assigned

after an invoice is approved for submission to your customer. This final invoice

number can be customized in the Accounting area. Click My Company, then in
Accounting, click Setup.

Submitting invoices to customers: When you approve an invoice, you can
submit the invoice electronically to your customer by entering your customer’s e-
mail address in the routing slip. Entering the e-mail addresses creates “guest”
accounts for your customers to view only the invoices that you send them.

Retract: Users can retract or “call back™ their actions, such as Approve and
Submit for Payment, Decline, or Forward. A retracted invoice returns to its
previous status.
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Reopen: Invoice creators (originators) can reopen their own mnvoices at any status
except when they reach Completed. Reopening an invoice voids all previous
approvals.

Previewing and Printing: You can easily preview and print out invoices by
opening an invoice and clicking the Print/Preview button. Another browser will
open, displaying the selected invoice. To preview and print, click the View as
Acrobat icon in the upper left area of the screen. The invoice will open in Adobe
Acrobat. To print, click the printer icon.

Purchase Requests

The Purchase Requests feature allows you to create and route purchase requests
within your company. Desired purchases can be tracked by project for easy,
accurate tracking of purchases, and for later billing to your customers.

Roles/Privileges

Any employee with an account (User ID and Password) can create a purchase
request and submit it for approval. To maintain and enforce your company’s
purchasing policies, only managers’ names appear in the routing slip for approval
of purchase requests.

Note: Usets can forward a purchase request for review to anyone in the company
with a login account.

Dependencies

The Purchase Requests application can be used without any initial setup.
However, there are a few features you may wish to set up to enhance the
functionality of the application:

Customers/Projects: The Purchase Request application allows users to assign
putchases to customers/projects. However, the application can be used without
this feature. If you want to assign purchases to customers/projects, you must first
set up your customers and projects in the Accounting area.

1. Click My Company, then in Accounting, click Customer List.

2. See the online Help for details on how to add both customers and projects.

Approval Routing: The System Administrator who sets up the company’s
account 1s assigned the Manager role, and will appear in the routing slip drop-
down box for approval of purchase requests. If you want to give other users the
ability to approve purchase requests, you must give them Manager access rights.
To do so, click My Company, then in System Admin, click Access Rights.
Users given Manager rights can also approve time sheets, expense reports and
invoices.

To inform your employees of your company’s purchase request approval policies,
you can easily create a policy in Policies and Procedures.
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Hints and Guidelines
Retract: Users can retract or “call back™ their actions, such as Approve, Decline,
or Forward. A retracted purchase request returns to its previous status.

Reopen: Purchase request creators (originators) can reopen their own purchase
requests at any status. Reopening a purchase request voids all previous approvals.

Previewing and Printing: You can easily preview and print out a purchase
request by opening it and clicking the Print/Preview button. Another browser
will be opened to display the selected purchase request. To preview and print, click
the View as Acrobat icon in the upper left area of the screen. The purchase
request will open in Adobe Acrobat. To print, click the printer icon.
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